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Preface 

This book presents both a data-rich case study across time of the Aydinli 
nomads (Yörük) in Southeast Turkey and a paradigm for new types of 
kinship, network and ethnohistorical analysis. As such it can serve as an 
instructional manual for new methods of kinship, marriage, historical, and 
ethnographic studies by means of network analysis. It is one of a series of 
new theoretical approaches (Brudner and White 1997, Houseman and 
White 1998a,b; Schweizer and White 1998, White, Schnegg, Brudner and 
Nutini 2000) concerned with obtaining a deeper, more precise and com-
prehensive understanding of social organization and dynamics.  

The approach taken in this book explores the continual emergence-
reemergence of shifting patterns of social groups and relations. Such van-
tage points are also achieved here by attention to the reports that people 
give of the sequence of their marriages, which provide data on the associ-
ated changes in their social networks. Like a text, these sequences follow 
in the context of relationships set down earlier, and show the result in ties 
that often change subsequently with the birth and raising of children, 
death, divorce, conflicts or key events. The data presented here, supple-
mented by analysis of other written and oral texts, are also transformed by 
visual rendering and analyses into a detailed network analysis of social 
organization, especially of marriage or alliance structure, descent groups, 
relevant cohesive groupings, and leadership factions. 
 We attempt both to visualize the complex relationships that arise in the 
unfolding of ethnographic narratives about social networks, including ge-
nealogies, and what is said about these relationships. In this manner we 
try to meet the demands of Holy when he writes: “we need to pay more 
systematic attention to people’s own models and conceptualizations if we 
are to advance our understanding of the constitutive relationship between 
their marriage preferences and other elements of the. . . reality” (1989:2). 
The analysis thus fits within the general frameworks of cognitive anthro-
pology, network analysis, and ethnohistory.  
 We hope to show how the fit of social organization with cultural rules 
and individual actors’ decisions becomes more transparent when we are 
enabled to see the unfolding of peoples’ behaviors, and often their thinking 
about social action. This we do by providing social networks as among the 
contexts in which people operate and to which their actions contribute. We 
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hope to show anthropologists and others how to combine genealogical 
data, network analysis, and social narratives to elucidate more precisely 
the principles and dynamics of social organization in a specific case study. 
The results of this analysis may give readers a deeper understanding of the 
complexity of socio-political organization generally, and of rural Turkey 
in the last centuries in particular. 
 In this study of a nomadic clan embedded in a larger intersocietal 
framework, the ethnography of Johansen and the computer analysis of 
White are combined to visualize and explore intricate social processes 
using genealogical and other data collected in the course of fieldwork. The 
full results of Johansen’s fieldwork will not be given here, but only as 
needed to provide the background data for the network analysis. The 
fieldwork is exclusively that of Johansen, and the computer analysis that 
of White. “We” is used or implied in the many statements and interpreta-
tions of ethnographic details that we worked out together, where our use 
of the computer-drawn genealogies and references to individuals in the 
genealogies have been crucial to observing further patterns in the ethno-
graphic data. During the cooperation, the advantages and possibilities of 
network analysis became more and more obvious to us both. Additionally, 
“we” is used as a didactic means to include the reader into the process of 
analysis. We felt it important to present aspects of the new analytic para-
digm within the framework of a detailed case study that extends existing 
theories about the particular forms of social organization exemplified by 
this ethnographic case. The paradigm elucidated in this study is of poten-
tial interest in social, cultural and physical anthropology and in social- 
and ethno-history and archaeology as well. We raise an explicit dialogue 
about the process of integrating ethnography and computing. In the chap-
ter summaries we recap some of the main arguments and findings, fol-
lowed by a list of further readings 
 The interlocking of ethnography and computing appears in the struc-
ture of the book. To link the two levels but keep them distinct, we intro-
duce explicit hypotheses beecause our findings in the analytic sections 
may then be independently checked by the ethnographer, and the ethnog-
rapher’s statements may be independently checked by the analysis. 

After methodological (Chapter 1), ethnographic (Chapter 2) and theo-
retical introductions (Chapter 3) end with the theory of fractal networks 
and their application to marriage and kinship structure provides a com-
plementary alternative to theories of descent and alliance. A preliminary 
set of hypotheses introduce some of the theoretical concepts and questions 
that help to guide the analysis of case materials and to place the Aydinli in 

List of  
Chs. and 
analyses to 
be updated 
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a broader class of societies with FBD marriage, a topic we examine in 
Chapter 6. There follow an overview of the structure of the nomad clan 
and a general methodical explanation of this structure that is our first sub-
ject of analysis (analyses 1 and 2). A short field report on this theme is 
deepened and made precise by computer analyses of relinkings by genera-
tion, lineages and tribes (Chapter 4). These analyses (analyses 3 - 8) in-
troduce the principal hypotheses of the study. The second leading subject 
is social rank, marriage and leadership (Chapter 5). Again the ethno-
graphic overview is complemented by analyses (8 - 11). They support the 
fieldwork results concerning interpersonal behavior within the families 
(Chapter 6). The third subject (Chapter 6) is marriage structure and dy-
namics, beginning with a review of Fredrik Barth’s (1953) hypotheses 
concerning the dynamics of nomadic social structures. Analyses 12 - 14 
supplement those of the previous chapter to show in a precise form the 
changing frequencies of marriage types noticed by the fieldworker, and to 
test hypotheses about the interpretation of these changes. The field-
worker’s impression that social cohesion through intermarriages was in 
decline in the course of the twentieth century, however, was corrected in 
certain critical aspects by computer analysis. Graphic representations that 
support the field report about leadership and clan structure and a dynami-
cal graph theoretical analysis (Chapter 7), and a final evaluation of the 
results of this study (Chapter 8), complete the book. The genealogies of 
the nomad clan used in the analysis are published in the Internet web site 
www.santafe.edu/turkishnomads, as a companion to this book, for the use 
of everyone interested in examining our results. We hope that this will 
enable others to identify new problems or means of analysis that we did 
not recognize in solving problems of analyzing social organization. 

 [[overview to be completed]] 
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The analytic sections of the 
book are accompanied by working 
hypotheses (numbered within each 
chapter) that are tested and cross-
validated with network methods as 
well as qualitative and quantitative 
analyses. To clarify key analytic 
concepts when first introduced and 
later used in the analysis, high-
lighted definitions are provided.  
 The assumption that there exists 
a language of behavior in no way 
diminishes the importance of norms, 
values and beliefs— and their ex-
pression in statements or texts— in 
the regulation of social life. The 
study of behavior is complementary 
rather than contradictory to these 
approaches. But to the extent that 
norms governing social relations—
and the more detailed rules of how 

norms are used in practical life— are 
inferred from social  
behavior, the book will demonstrate that it is a far superior method to ex-
amine behavior in the context of actual networks and the contexts that 
define the range of possible choices in behavior. 
 This book is dependent on a thoroughgoing use of the genealogical 
method. One of its main contributions is to enhance our ability to trace not 
only the ethnogenesis of the nomad clan, from its origins in the 18th cen-
tury, but also the movement of clan peoples back and forth from no-
madism to sedentism as the clan grew in size. This eventuated in a nu-
merical preponderance of the descendants of the nomadic clan settling or 
resettling in sedentary villages. Whether this process is also resulting in 
the dissolution of the clan as a nomadic society will also pose a series of 
question for analysis. 
 Many of the themes developed here are echoed or presaged by 
Schweizer (1996), who provides for the German-speaking community a 
history and critique of ethnology and a presentation of the advantages of 
the network approach. He shows the benefits of a dynamical network ap-
proach by way of well chosen examples, without entering as we do here 

A Language of Behavior. The 
root assumption of this study, 
which defines the theoretical 
approach taken in the book, is 
that there is a language of be-
havior that can be read and un-
derstood with certain new 
forms of network analysis when 
combined with an ethnogra-
pher’s understanding of indige-
nous knowledge systems. Pref-
erences and social rules can be 
inferred from actual choices 
made in a network context; i.e., 
from knowledge of the network 
background of possible choices 
as a system of constraints, and 
of course some knowledge of 
the cultural background and 
indigenous knowledge systems. 
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into the theory of graphs as it underlies the network approach. He illus-
trates, for example, by means of successive graphs of relations amongst 
actors involved in positions of power, the evolution of social hierarchy and 
positions of power in a Chinese village after the Maoist Revolution. In a 
second example, he reexamines the emergence of social hierarchy in ritual 
exchange by means of network analysis the case of the !Kung, whose 
egalitarian ideology contrasts with hierarchy at the level of exchange. 
 The approach taken in this book goes well beyond Wasserman and 
Faust’s (1994) presentation of currently standard types of network analy-
sis in the social sciences. It adopts the kinds of ethnographically and 
graph-theoretic perspectives pursued by Hage and Harary (1983, 1991, 
1996), in which graph theory is put to use to define and formalize new 
concepts that are directly relevant to ethnology. White’s presentation of 
new software and computational possibilities for the analysis of large-
scale networks also goes beyond the confines of the smaller ethnographic 
vignettes of Hage and Harary that are necessitated by relying on manual 
rather than computer-driven analysis. The further elements of graph the-
ory developed here (such as concepts of relinking, structural endogamy, 
cohesion, etc.) are those thought to be directly useful for studying dynamic 
phenomena in social organization and the emergence of well-structured 
forms of cohesion applicable to social groups and institutions.  
 Our book will be successful if it helps to orient a new generation of eth-
nographers, if only in part, to change the nature of ethnographic practices 
in systematizing, analyzing and reporting their data, given the availability 
of analytic concepts and computer software for network analysis of the 
relational data that are necessarily collected in their case studies. 
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“Before you begin your critique of the Iroquois,” a Russian saying goes, 
“you need to undertand their language.”— Andrey Korotayev 

 
The vocabularies we use derive from anthropology (kinship, social roles), 
sociology (social networks, norms), graph theory (graphs, networks), 
complexity theory (fractals, power laws) and hybrids (network concepts 
for kinship). We place the glossary here because it will be easier for the 
reader to absorb the text of the book after reading the glossary. Glossary 
terms are given a gray gloss in the text to indicate where to look when 
unfamiliar or technical terms are encountered. References are provided to 
sources where methods and computer software are discussed, such as Pa-
jek (Batagelj and Mrvar 1998) and UCINET (Borgatti, Everett, and 
Freeman 1992). Where software commands are possible to implement 
some of the operational terms, the commands are given in glossary end-
notes. Additional terms that require illustration and conceptual under-
standing are given where needed in the text. 
 
Ethnographic and Sociological Vocabulary: 

Behavior. An observed regularity in a person’s actions, or a pattern of 
similar actions of members of a group. 

Constraint (on behavior). One or more external circumstances 
that together limit the scope of an action or behavior.  
Preference. A regularity in behavior that favors one alternative  
significantly above chance levels within a set of unconstrained al-
ternatives and attributable to a valued choice rather than to con-
straints on behavior. Care must be taken in attributing preferences, 
and they are not necessarily stable. 
 

Norm. An regularity in a people’s actions, as members of a group, ei-
ther in practice or stated as an ideal. 

Statistical Norm. A rule of behavior that applies to members of a 
group, usually including a hierarchy of exceptional subrules.  
Ideal Norm. A cognized and culturally shared statement of how 
people should behave, not necessarily corresponding to how people 
do behave. 
Prescription. An ideal norm that purports to allow no deviation in 
terms of actual behavior.  
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Role Relations. Observed social behaviors associated with norms 
stated by members of a group. The following are examples in the kin-
ship domain that are relatively self-explanatory and widely used in eth-
nographies, presumably because there are either easily observed or 
comprehensibly verbalized or both: 

Avoidance.  
Authority. 
Respect. 
Informality. 
Joking. 

 
Graphs: de Nooy, Mrvar and Batagelj (2002) provide a manual that stu-
dents can consult for the software for graphical representation and net-
work analysis used in this book. We mostly follow their terminology. As a 
qualitative or relational branch of mathematics (Harary 1969), formal 
definitions build on earlier definitions or primitives, here marked in gray. 

Node. The elements of a graph that are represented as points, and con-
nected by lines (see below). Synonym: vertices. 
 
Line. A relation between a pair of nodes. Its two defining endpoints 
are incident with the line. A line may be directed or undirected. An 
undirected line is an edge and an undirected line an arc. A loop is a 
special kind of a line that connects a node to itself. Lines may be mul-
tiple between the same pair of nodes. 
 
Graph. A set of nodes and a set of lines between distinct pairs of 
nodes.1 A multigraph has multiple lines between nodes. A digraph 
has arcs but no edges, although arcs may be bi-directed and thus rep-
resented as edges.2 A graph may have arcs or edges or both, but a 
simple graph has only edges.3 A (directed) path in a graph is an alter-
nating sequence of nodes and (directed) edges that connects two nodes 
without any repeated nodes or edges. A (directed) cycle is the same as 
a path except that the endpoints are the same. 
 
Relation. A graph with the addition of loops.4 See tie. A multiple re-
lation has multiple lines between nodes. A directed relation has arcs 
but no edges (although edges may be bi-directed and thus represented 
as edges). A relation may have both arcs and edges, but a simple rela-
tion has only edges. Graphs and relations may be equivalently repre-



 
 
 
 
 
 
 
 

Glossary 

 

xix

sented by a matrix in which columns represent nodes, arcs, edges or 
loops are represented by ones, and their absence is represented by ze-
ros. Operations on the matrix will have corresponding operations de-
fined on the graph or relation. 

 
Networks Vocabulary: 

Network. A graph or relation with additional information on its nodes 
or lines: e.g., a social network implies a correspondence between a 
graph that represents individuals as nodes and social relations as lines.5 
A subnetwork is a subset of the elements (nodes, e.g., representing in-
dividuals) in a network together with all the information pertaining to 
the nodes and the lines between them.6 A object with a mathematical 
property is maximal with respect to this property in a given context, 
such as a subnetwork or graph, when there is no larger object within 
the context that contains it that has that property. 
 
Tie. A set of relations between nodes in a network (e.g., a social net-
work) that can be represented by lines in the graph of the network and 
for which there is additional information about the nodes and their 
relations. A simple tie is a single relation; a multiplex tie is one with 
multiple relations.7 A tie between A and B in a social network is recip-
rocal when there is evidence that A gives to B and B gives to A, with-
out an a priori constraint of symmetry. Sets of ties in a subnetwork are 
transitive when, for each triple, A, B and C, a tie from A to B and 
from B to C is always accompanied by one from A to C (see triad). 
 

Methods of Graph and Network Analysis: 
Cohesion.8 The cohesion of a network or subnetwork is measured by  
k-connectivity (White and Harary 2002): the minimum number k of 
nodes that must be removed to disconnect it. To say that a graph has 
connectivity k is equivalent to saying that every pair of nodes is con-
nected by k or more completely distinct paths (Harary 1969). This way 
of conceiving of cohesion a classical one in graph theory, but so time-
consuming and complicated to compute that network analysis using 
this concept only began with Moody and White (2000). A network can 
be decomposed into embedded cohesive hierarchies consisting of k-
components: maximal subnetworks corresponding to each level of k-
connectivity. Elaborations are given in the text. The embeddedness of 
a person in a subnetwork is the connectivity of the most cohesive k-
component to which that person belongs. 
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Hierarchical Clustering.9 A method for showing hierarchical subsets 
of elements in a matrix or network in which all pairs of elements in the 
each subset have a minimum {average, maximum} value.  
 
Automatic drawing.10 Optimal layouts of graphs that minimize line 
length, in which cohesive sets of nodes tend to be clustered, and hierar-
chical clustering of cohesive sets can be easily superimposed. Energy 
commands in the Pajek program implement these automated proce-
dures: 

Energy commands move nodes to locations that minimize the varia-
tion in line length. Imagine that the lines are springs which pull ver-
tices together. The energy commands ‘pull’ vertices to better posi-
tions until they are in a state of equilibrium. Therefore, these proce-
dures are known as spring embedders.— de Nooy, Mrvar and 
Batagelj (2003)  
 

Triple.11 A set of three nodes in a network or three of its subnetworks. 
A triad census of triples is a common means of estimating the degree 
of reciprocity, transitivity, ranking and other local attributes of a net-
work. A triple is complete when each pair of its nodes are an arc or 
and edge, or, in a social network, a tie. 
 
Curvature. For ties that are reciprocal between social units in a net-
work, the local curvature of each unit A is the ratio of complete triples 
A, B, C to triples where A-B and A-C have reciprocal ties. Clusters of 
adjacent nodes with high curvature constitute a topology of a network 
(Eckmann and Moses 2002).  

 
Centrality.12 A property of a node that depends on its relation to other 
nodes in a graph: degree centrality is the number of lines incident to a 
node; closeness centrality is a function of the number of lines in all the 
shortest paths needed to reach all the other nodes in a graph; and be-
tweenness centrality (Freeman 1977, 1980) is a function of the num-
ber of pairs of other nodes in a graph weighted by the proportion of the 
shortest paths between each pair that pass through a given node. These 
might be useful to measure, respectively, the activity of a node in a 
network, the potential influence of a node over others, or the control a 
node has in mediating connections between others.  
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Recursive centrality.13 The extent to which a node is connected to 
others that are central, eigen centrality, is measured by the first eigen-
vector in a principal components analysis of a network matrix (ei-
gen=own, in German, connotes that every matrix has a unique set of 
principal component vectors whose vector product sums reproduce the 
matrix). 
 
Centralization.14 A measure of the extent to which a graph has the 
greatest possible difference of centrality between the most central node 
and each the other nodes. For each measure of the centralities of indi-
vidual nodes, the centralization measure of the graph is standardized 
between 0 and 1, where 1 is the centralization of the star graph. This 
allows centralization to be compared across different networks. 

 
Cohesion and Edge Betweenness.15 Edge betweenness is a centrality 
measure of the number of pairs of nodes in a graph weighted by the 
proportion of the shortest paths between each pair that pass through a 
given edge. Girvan and Newman (2002) show that hierarchical clusters 
of edges with low betweenness identify embedded cohesive hierar-
chies with a high degree of accuracy. 

 
Kinship Vocabulary: see also the Kinship Glossary compiled by Michael 
D. Murphy at http://www.as.ua.edu/ant/Faculty/murphy/436/kinship.htm. 

Types of Kin – e.g., MBD, FZD, FB, FBD, MZ, MZD, HZ, BW.  
These compounds are used to stand for particular types of rela-
tives, where the individual letters stand for mother (M), father 
(F), sister (Z), brother (B), wife (W), husband (H), daughter 
(D) and son (S). FBD, for example, is father’s brother’s daughter. 

 
Asset and Marriage Transfers: 

Wealth-asset. See text, page (currently 134). Inheritance is a 
binding transfer of wealth-assets or consumables after or anticipat-
ing a death to a customary set of heirs. Testamentary disposition 
is the annulment of inheritance through the substitution of a written 
will left by the deceased. 
 
Bridewealth. A transfer of wealth-assets from a husband’s wealth-
holding group to the wife’s at and following marriage, in exchange 
for reproductive rights transferred from the wife’s group (e.g., over 
their daughter’s offspring) to the husband’s (e.g., children are re-
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tained by the man’s lineage). Bridewealth is typically in the form of 
animals such as cattle that qualify as a wealth-asset. Bride price is 
a term that can be used to contrast with bridewealth, when only 
consumables are transferred at marriage, but is out-of-date because 
of the association with purchase, which is an inappropriate term. 
Bride payment is synonymous with bridewealth except that either 
wealth-assets or consumables may be transferred. 
 
Dowry. A transfer of wealth-assets or consumables from the wife’s 
group to the wife in connection with her marriage. Note the 
aysmmetry with bridewealth: dowry transfers are typically not to 
the husband or husband’s group. 

 
Descent Groups: 

Clan. A descent group or category whose members trace descent 
from a common putative ancestry, where genealogical links to a 
single apical ancestor are not known. 
 
Lineage. A corporate group whose members share a common an-
cestor. An ambilineage is a lineage whose members share a com-
mon cognatic ancestor and affiliate either through their father or 
mother but not both. A sib is a lineage that is distributed across 
multiple communities. 

 
Affinity and Descent: 

Agnatic. A relation between two descendants of the same ancestor 
trace exclusively through males. Synonym: Patrilineal. A patri-
lineage is a corporate group whose members share agnatic descent. 
 
Uterine. A relation between two descendants of the same ancestor 
trace exclusively through females. Synonym: Matrilineal. A matri-
lineage is a corporate group whose members share uterine descent. 
 
Cognatic. A relation between two descendants of the same ances-
tor. Synonym: Bilateral. A kindred is an ego-centered group …  
whose  
 
Unilineal. An agnatic or uterine descent principle. An ambilineal 
descent principle is operative in an ambilineage. Bilateral descent 
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is reckoned by the cognatic principle, i.e., through both males and 
females. 
 
Consanguineal. Two persons are consanguineals if they have one 
or more common ancestors. 

 
Affinal. Two persons are affinals if a relation between them can be 
traced that includes a tie of marriage. In-laws are the consanguin-
eals of a spouse or the spouses of consanguineals, but longer chains 
of relationship such as the spouse of a consanguineal of a spouse of 
a consanguineal (e.g., HZHZ) or a consanguineal of a spouse of  a 
consanguineal (e.g., BWB) are affinals in the more extended sense 
of the term. 
 

Post-Marital Residence: 
Patrilocal. A married couple goes to live in the household of the 
husband’s parents. Synonym: Virilocal. In Murdock’s (1967) vari-
ant, patrilocal entails residence with the husband’s patrilineage. 
 
Matrilocal. A married couple goes to live in the household of the 
husband’s parents. Synonym: Uxorilocal. In Murdock’s (1967) 
variant, matrilocal entails residence with the wife’s matrilineage. 
 
Neolocal. A married couple sets up their own household independ-
ent of other set of parents. There are of course many other alterna-
tives that the three given here, each having many possible subtypes 
(and potential difficulties for classification of households!). 
 

Complexity Theory: Complex systems have embedded interiors with 
many interacting parts, networks, and fields. From a mechanical point 
of view, emergent field processes often lead to ‘surprising’ results that 
are not reducible to a mechanical or deterministic account. ‘Emergent’ 
behaviors at one level are not determined by the embedded levels that 
produce them but are the result of complex interactions. 

Complexity. Interaction between a system and its changing envi-
ronment is complex when system responses to changes are on 
longer time scales than the tempos of environmental change. Degree 
of complexity is a function of the ratios of response time to peri-
odicities of changes in inputs. Complex systems can pack memory 
into their internal states. 
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Tipping Point. When certain thresholds are passed in a network or 
field internal to a complex system, such as a critical density or 
alignment, the global properties of the network or field change 
qualitatively, and can pass on this ‘emergent’ or structural change 
to a more aggregate level in the system of which the network or 
field is a component. 
 
Fractality. Properties or behaviors that are fractal are self-similar 
at different levels of spatial scale (e.g., the appearance of an ‘edge’ 
of a coastline at different resolutions) or temporal scale (e.g., the 
appearance of variation of stock prices at different time intervals). 
Complex systems often have fractal properties. Many mechanical 
rules (e.g., growth of savings in an account with fixed interest) and 
random processes (e.g., distribution of the number of edges of 
nodes in a graph in which edges are added to new pairs of nodes 
that are chosen with a uniform probabilities) have a characteristic 
exponential distribution. Fractal processes that result from interac-
tion of two levels (a complex system), such as earthquakes at one 
level and the random distribution of frictional stresses along poten-
tial fault lines at a lower level that affects the production of the 
earthquake however, typically have the signature of a log-log 
power law distribution that is fractal or scale invariant over a large 
range of spatial or temporal resolutions in which the log of magni-
tude varies linearly with the log of temporal frequency. Power-laws, 
unlike savings accounts, typically imply that the short-term past is 
no guide to the long-term future. 

 
 Network-Defined Concepts in Kinship: 

Structural Endogamy.16 When a genealogical network contains a 
maximal subset of families of which each pair is linked through two 
or more completely distinct ties of affinity or descent, they are 
structurally endogamous. Derived from the more general concept of 
cohesion, and hence from the theory of graphs, and in such a way 
that the boundaries of structurally endogamous groups are emer-
gent from the pattern of relationships in the network. 
 
P-graph.17 In a genealogical network represented as a p-graph, 
couples or unmarried individuals are identified with the nodes, and 
lines are drawn between each node identified as a parent or parents 
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and every other node identified with a corresponding daughter or 
son. Two types of ones can be distinguished one for daughters and 
one for sons. When a person has multiple marriages, each marriage 
will have a line to the same parent. If we consider the underlying 
graph, structurally endogamous subnetworks corresponding to co-
hesive sets.  
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Notes to the Glossary 
                                                        
1 The exclusion of loops in this definition of graph is standard in graph theory 
(Harary 1969), and makes it easier intuitively to conceptualize some of the 
main theorems about the traversability of graphs. 
2 Pajek options [Main] Net>Transform>Arcs? Edges>Bidirected only. 
3 Harary’s (1969) definition of graph is synonymous with simple graph, which 
he distinguishes from a digraph (directed graph) with directed edges (arcs). 
4 Network analysis packages (Pajek and UCINET for example) are capable of 
analyzing relations (containing loops) and not just graphs, and of course, ana-
lyzing the attributes of nodes as well. 
5 See the previous footnote (4). 
6 Given a partition on the nodes of a network, or a cluster with selective num-
bers for a set of nodes, [Main] Operations>Extract from Network>Partition or 
>Cluster will extract a subnetwork according to the user’s specification of the 
node set. 
7 [Main] Transform includes options to >Remove>Multiple lines in various 
ways that reduce them to simple lines and to convert >Arcs? Edges or 
>Edges?Arcs. 
8 [Main] Net>Components>Bicomponents with default size set to 3 or more 
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identifies sets of nodes with connectivity 2 or more. Tricomponents have yet to 
be implemented in current network packages (but see edge betweenness). 
9 UCINET’s Network>Cohesion>Maximum Flow or Point Connectivity options 
automatically perform a hierarchical clustering analysis of a matrix of pairwise 
cohesion values. 
10 [Main] Draw>Draw Partition, [Draw] Layout>Energy>Fruchterman-
Reingold>2D or 3D, and [Draw] Layout>Energy>Kamada-Kawai>2D or 3D. 
11 [Main] Info>Network>Triadic Census. 
12 [Main] Net>Partitions>Degree and Net>Vector>Centrality>Betweenness or 
>Closeness compute the centrality measures for nodes. Degree are computed by 
Pajek centralities  for up to one million nodes and closeness and betweenness 
centralities for up to ten thousand nodes.  

Flow centrality is another measure (Freeman, Borgatti and White 1991), 
computed by UCINET. When we assume that each edge in a graph has a trans-
port capacity of one unit, the flow centrality of a node u is the percentage of the 
total amount of flow between all pairs of nodes that is not reduced when node i 
is removed from the graph. 
13 Eigen centrality is computed in the UCINET program package. 
14 Automatically computed in both the UCINET and Pajek program packages 
when centrality scores are calculated. 
15 Edge betweenness is computed in the UCINET program package. Hierarchi-
cal clustering of dissimilarity scores may be applied to show cohesive groups.  
16 [Main] Net>Components>Bicomponents with default size set to 3 or more 
identifies blocks of structurally endogamous marriages for a genealogical data-
base in p-graph. 
17 Pajek’s [Main] File>Network>Read uses the p-graph format suitable for net-
work analysis as the standard default for reading databases in *.GED formats 
used by commercial and freeware genealogical programs and produced as well 
by Pgraph software.  


